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HƯỚNG DẪN SỬ DỤNG PHẦN MỀM CAMTASIA 8 

 

I. GIỚI THIỆU CHUNG 

Camtasia Studio 8 là phần mềm hỗ trợ quay video màn hình Windows cho 

phép bạn ghi lại từng mili màn hình với chất lượng tốt nhất. Khả năng làm việc 

của Camtasia Studio thì các bạn không cần phải bàn, nó rất đơn giản để sử 

dụng ghi lại màn hình của mình. Đặc biệt, khi sử dụng chương trình này để 

quay lại video màn hình bạn sẽ không cảm nhận được độ trễ của máy.  

Khác hẳn với các chương trình hỗ trợ quay video khác, Camtasia Studio 

được sử dụng nhiều nhất bởi các tính năng mà nó hỗ trợ cho người dùng rất tốt 

và tiện lợi. Nó hỗ trợ người dùng ghi lại màn hình một cách trực quan nhất sau 

đó cung cấp các công cụ hỗ trợ tốt nhất để người dùng thao tác chỉnh sửa video 

ở phần cuối trước khi xuất ra video. 

Camtasia Studio 8  được sử dụng nhiều nhất vào trong các mục đích như 

giảng dạy, hướng dẫn, kinh doanh, bán hàng và tiếp thị. Nếu như bạn là một 

giáo viên thì đây là phần mềm hoàn hảo để bạn tạo ra một bài giảng có giá trị 

thực tế và truyền đạt được nội dung khá hay. Ngoài việc quay video màn hình, 

Camtasia Studio còn hỗ trợ thu âm nên bạn vừa có thể thao tác vừa có thể 

truyền tải được nội dung của mình qua âm thanh. Hơn nữa, việc hướng dẫn sử 

dụng hay kinh doanh, tiếp thị bán hàng sẽ trở nên dễ dàng hơn khi bạn có thể 

mô tả một cách chi tiết nhất các hành động trên video mà qua đó có thể cho 

thấy giá trị thực hơn. 

Camtasia Studio 8  có thể tương thích và hoạt động trên các nền tảng hệ 

điều hành của Microsoft như Windows XP/Vista/7/8. Nó không yêu cầu cấu 

hình quá cao nhưng cần có sự hỗ trợ tốt nhất từ Microsoft DirectX 9 hoặc cao 

hơn bao gồm cả Microsoft .NET 4.0 Client Profile. Bộ vi xử lý tối thiểu là 

Dual-core trở lên với bộ nhớ RAM 2GB thấp nhất và 4GB hoặc cao hơn để hỗ 

trợ khi render (làm) video. Bộ nhớ HDD tối thiểu 2GB để cài đặt chương trình 
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và màn hình hiển thị thấp nhất là 1024×768. Ngoài ra, bạn nên trang bị thêm 

microphone, speaker để thu âm và nghe lại khi phát video. 

II. HƯỚNG DẪN CÀI ĐẶT 

Bước 1: Ngắt mạng. 

Bước 2:   Mở file C:\Windows\System32\drivers\etc\hosts bằng notepad 

thêm vào cuối file host nội dung sau: 

127.0.0.1       activation.cloud.techsmith.com 

127.0.0.1       oscount.techsmith.com 

Bước 3: Mở thư mục chứa file cài đặt 

 

- Click đôi vào file camtasia.exe  

- Xuất hiện hộp thoại: Click vào Next. 
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- Xuất hiện hộp thoại sau: Chọn I accept the license agreement  rồi 

click Next.

 

- Xuất hiện hộp thoại sau: Improve Camtasia Studio by collecting usage 

data. Rồi click Next. 

 

- Mở file hướng dẫn lên lấy Key. 

- Chọn và thực hiện như hình vẽ.  
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- Click  vào Enable Camtasia Studio Add-in for Microsoft 

PowerPoint để kích hoạt tích hợp vào PowerPoint. 

 

- Chọn Next và sau khi cài đặt xong thì chọn finish. 
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- Mở lại mạng và hoạt động bình thường. 

III. CÁC CÔNG CỤ VÀ CHỨC NĂNG CHÍNH 

1. Ghi lại hoạt động trên máy tính 

Công cụ này thật đơn giản nhưng là một công cụ ghi hình mọi hoạt động trên 

màn hình máy tính cực hay. 

2. Hiệu chỉnh lại đoạn phim ghi được 

 Đoạn phim ghi được có thể bị một vài lỗi nhỏ, và với công cụ này bạn đã có thể sửa 

lỗi để làm hoàn chỉnh hơn sản phẩm của mình 

 

3. Xuất đoạn phim ra một định dạng theo yêu cầu 

Sau khi đã chỉnh sửa ưng ý, đây là lúc chọn một định dạng để xuất ra theo yêu 

cầu công việc: dạng video thường hay dạng flash…. 

4. Chia sẻ và trình chiếu giáo trình điện tử 

Khi sản phẩm đã hoàn thành, bước cuối cùng là quyết định xem sẽ sử dụng sản 

phẩm này như thế nào. Camtasia studio hỗ trợ nhiều cách để đưa ra sản phẩm 

trực tiếp đến nơi muốn giới thiệu (CD, DVD) hoặc gián tiếp qua Internet(web, 

email). 

IV. GIAO DIỆN CAMTASTUDIO 
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1. Khởi động phần mềm 

Sau khi cài đặt xong nhấp vào biểu tượng Camtasia 

Studio 8 trên Desktop. 

Tiếp theo sẽ hiện ra bảng Welcome, có 2 khung chức năng 

chính: ghi màn hình, chèn âm nhạc phim ảnh. 

Hộp thoại này sẽ không xuất hiện lúc khởi động chương trình nếu nhấp 

chuột vào dòng chữ Show this dialog at startup. 

 

2. Giao diện khởi động 

 

V. QUAY PHIM BÀI GIẢNG POWERPOINT 
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 Bước 1 : Khởi động chương trình Record PowerPoint. Có 3 cách: 

 Cách 1: Khởi động chương trình Camtasia studio. Hộp thoại 

Welcome xuất hiện với 3 tùy chọn, chọn mục Record PowerPoint, 

chọn tập tin powerpoint cần quay phim. 

 Cách 2: Chọn Record PowerPoint ở thanh Menu, chọn tập tin 

PowerPoint cần quay phim. 

 

 Cách 3: Mở Powerpoint, sẽ thấy tích hợp sẵn Camtasia studio, mở tập 

tin PowerPoint cần quay phim, nhấp vào thẻ Record. 

 

 

 

 

 

 Bước 2: Nhấp vào Click to begin recording. 
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 Bước 3: Nếu muốn ngừng quay, nhấn ESC hooặc “ Ctrl + Shift + F10” 

sau đó nhấp Stop recording, chọn đường dẫn để lưu đoạn phim /nhạc. 

 

 

Chương trình mặc định cho phép lưu lại tập tin hệ thống có định dạng Camrec 

để có thể chỉnh sửa sau này. 

 Bước 4: Nếu chọn mục 1 và chọn OK thì xuất phim với kiểu định dạng khác 

nhau (xem ở phần xuất phim/nhạc). Nếu chọn mục 2 và chọn Ok thì tiến hành 

biên tập (xem phần biên tập phim). 

 

 

VI. QUAY PHIM MÀN HÌNH 
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Bước 1: Khởi động chương trình, chọn Record the screen ở thanh menu. 

 

Bước 2: Bảng công cụ ghi màn hình xuất hiện với các tùy chọn sau: 

 

- Full sreen: Ghi toàn bộ diễn tiến của màn hình. Trên màn hình xuất hiện 

khung viền toàn bộ màn hình, ở cạnh khung có 8 nút để điều chỉnh kích cỡ 

của vùng màn hình. 

- Custom: Chọn kích thước ghi màn hình khác nhau, được chia thành 2 nhóm 

tỷ lệ 16: 9 và 4: 3. Khi chọn xong, khung ghi sẽ xuất hiện trên desktop, nhấp 

lên tâm của khung ghi và kéo đến vị trí cần ghi. 

Lock to application: Khóa lại để áp dụng một tùy chọn trước đó. 

 

 

 

 

Select area to record: Chọn một vùng ghi tùy ý, kéo trên desktop để tạo vùng 

cần ghi, kích thước màn hình sẽ hiện ra. 
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- Webcam off: Tắt mở webcam, có 3 tùy chọn: 

Mở webcam, sẽ hiện ra khung hình webcam, nhấp vào khung, màn hình 

webcam được phóng to. 

 

 

 

- Audio off: Tắt mở audio để thu âm, có các tùy chọn sau: 

Sau khi đã chọn lựa xong, nhấp Record để ghi màn hình, sẽ xuất hiện 

bảng thời gian đếm ngược từ 3 đến 1, sau đó bắt đầu ghi hình. 

Trong lúc ghi màn hình, có thể thao tác trên bảng công cụ ghi hình hoặc 

nhấn phím nóng: F9 ( bắt đầu ghi; tạm dừng ghi), F10 (ngưng ghi). Nếu 

không muốn mặc định phím nóng là F9 và F10, thì vào Option -> Hotkeys 

đê thay đổi. 
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 Bước 3: Nếu muốn kết thúc ghi hình, nhấp Stop trên bảng công cụ ghi hình 

hoặc nhấn phím F10. Khi đó sẽ hiện ra khung hình để xem đoạn phim vừa ghi. Có 3 

tùy chọn: lưu lại và biên tập, xuất phim, xóa phim. 

 

 

VII. BIÊN TẬP PHIM 

Trước khi biên tập, chúng ta phải nhập toàn bộ những tập tin cần thiết vào 

khung Clip Bin. 

Nhấp thẻ Import media trên thanh menu, chọn tập tin (phim, âm thanh, hình 

ảnh) cần biên tập, nhấp Open. Tập tin xuất hiện trong khung Clip Bin, kéo tập tin và 

thả vào khe Video của khung Timeline. Bảng Editing Dimensions hiện ra hỏi xem 

có muốn chọn lựa kích thước khác không, sau đó nhấp OK. Nhấp nút Play trong của 

sổ Preview để xem, đồng thời ở bên dưới nút trượt (xanh đỏ) sẽ chạy trên vạch thời 

gian trình chiếu. 
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Nếu là đoạn phim được ghi từ tập tin PowerPoint có chú thích (notes), khi 

kéo xuống khe Video bên dưới, sẽ xuất hiện hộp thoại hỏi xem có nhập những chú 

thích này không. Nếu nhấp Yes, những chú thích đó sẽ xuất hiện ở dưới phim (kiểu 

như phụ đề). 

1. Cắt ghép phim, nhạc, hình ảnh 

Ghép phim/ nhạc:  Những đoạn phim, nhạc, hình ảnh cần thiết đã xuất 

hiện ở khe video, nếu cảm thấy không cần chỉnh sửa gì nửa thì có thể xuất 

phim (xem phần xuất phim). Phim khi xuất ra sẽ bao gồm nhiều đoạn 

phim, ảnh, âm thanh nối liền với nhau. 

Cắt phần đầu/ cuối phim/ nhạc: Kéo chuột đến đầu hoặc cuối đoạn 

phim/ nhạc, khi hiện ra mũi tên trắng thì kéo chuột sang phải hoặc sang 

trái, và thả chuột ra khi đã ưng ý. Sau đó có thể xuất phim/ nhạc nếu không 

cần chỉnh sửa gì nữa. 
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Tách phim và nhạc: Thông thường phần Video và phần Audio của 

một đoạn phim nào đó luôn gắn chặt với nhau. Nếu muốn cắt phần đầu của 

Video nhưng giữ nguyên phần Audio thì phải vào nút Edit > Chọn Unlink 

Audio 1 from Video 1 (hoặc nhấp vào điểm sáng ở Video 1 đầu khung 

Timeline) > Yes. 

 Cắt phim/ nhạc thành nhiều đoạn: Kéo nút trượt đến vị trí cần cắt, 

nhấp vào nút Split (hoặc nhấn phím S, hoặc nhấp chuột phải, chọn Split). 

 

 Ghép dữ liệu khác vào chỗ vừa cắt: Trước tiên, nhập phim/ nhạc, 

hình ảnh cần ghép vào Clip Bin, sau đó kéo dữ liệu xuống khe  Video, vào 

đúng chỗ vừa cắt bỏ. Khi đã hài lòng, ta có thể xuất phim. 

 Cắt bỏ hoặc sao chép đoạn giữa:  

 Ví dụ cần cắt bỏ hoặc sao chép từ đoạn A đến B trong phim, kéo nút 

trượt đến vị trí A, sau đó tách nút trượt màu xanh lá cây và màu đỏ 

ra, kéo nút màu đỏ sang B. 
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 Nhấp chuột phải vào đoạn A->B, nếu cắt vỏ, chọn Cut (hoặc nhấn 

Ctr + X); nếu sao chép chọn Copy (hoặc nhấn Ctrl + C). 

 Dán vào một vị trí khác trên Timeline bằng cách nhấp phải, chọn 

Paste (hoặc nhấp Ctrl + V). 

 Lưu ý: đoạn phim/ nhạc gốc vẫn không bị thay đổi. Nếu không 

biên tập gì nửa thì xuất phim. 

2. Tạo hiệu ứng chuyển cảnh 

 Click Transitions để tạo hiệu ứng chuyển cành. 

Vị trí vùng 

được chọn 

của Video 2 

Click chuột 

phải. 



Phần mềm Camtasia Studio 8 Page 17 
 

 

 Chọn hiệu ứng, kéo thả vào đoạn video mình muốn. Nếu muốn thay 

đổi hiệu ứng khác thì click chuột phải tại hiệu ứng cần thay đổi và 

nhấp delete. Và chọn hiệu ứng rồi kéo thả vào chỗ cần thay đổi. 

 Điều chỉnh thời gian hiệu ứng: chọn hiệu ứng cần điều chỉnh, nhấp 

chuột phải, chọn Transition duration. 

 Có thể điều chỉnh thời gian như nhau cho các hiệu ứng bằng cách 

vào Tools > Options > Transitions. Bằng cách này cũng có thể 

điều chỉnh thời gian trình chiếu của hình ảnh, chú thích… 
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- Xuất hiện hộp thoại: 
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3. Tạo trang giới thiệu 

Nhấp vào More, chọn Library, nhấp Title clips – Simple, sau đó chọn khung 

mong muốn. 

Nhập lời giới thiệu (tên phim, tác giả…) vào Text, sau đó chỉnh kiểu chữ, 

kích cỡ, màu chữ, dạng chữ, màu nền, hình nền…tùy ý. 

Có thể điều chỉnh thời gian của trang giới thiệu bằng 2 cách: đưa chuột đến 

cuối Title clip (ở khung Timeline) và kéo sang trái hoặc phải; hoặc nhấp chuột 

phải vào Title clips ở khung Timeline, sau đó chọn Title duration. 

Nếu muốn tạo trang giới thiệu ở giữa phim thì trước tiên phải tách đoạn phim ở vị 

trí cần chèn. 

 

4. Tạo chú thích 

Khi muốn chú thích một vị trí nào đó trong phim và tạo nhiều hình thù 

đặc biệt cho chú thích, ta tạo callout như sau:  

 Nhấp vào Callouts ở thành công cụ, nhấp Add callout. 

 Nhấp chọn biểu tượng callout, chọn kiểu chữ, kích cỡ, màu chữ, 

màu khung viền, sau đó nhập nội dung vào. Có thể kéo chú thích 

đến vị trí tùy ý hoặc xoay theo bất kỳ hướng nào cũng được. 
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 Chú thích mới tạo sẽ xuất hiện ở khe Callout trong khung Timeline. 

 

 Điều chỉnh thời gian chú thích: đưa chuột đến cuối callout ở khe 

Callout trong khung Timeline và kéo sang trái hoặc phải; hoặc nhấp 

chuột phải vào callout ở khung Timeline, sau đó chọn Title 

duration. 

 

5. Viết ghi chú lên đoạn phim 

Nhấp vào More, chọn Captions. 

Trong khung thoại, nhập đoạn ghi chú cần hiển thị trên đoạn phim. Nếu 

quan sát ở cửa sổ Preview thấy đoạn chú thích hiển thị chưa được đẹp, 

nhấp chọn nút công cụ Overlay để đưa đoạn chú thích lồng hẳn vào biên 
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dưới của phim, chứ không chừa khoảng đen phía biên dưới như mặc định. 

Thông số trong khung Width (in class) càng lớn thì kích thước của dòng 

chữ chú thích sẽ càng nhỏ. 

Khi hoàn tất, dòng chữ ghi chú cũng sẽ thể hiện ở khe Caption trong 

khung Timeline. 

 

6. Thu âm cho phim 

Khi ghi hình bài giảng mà chưa thu lời giảng, hoặc muốn thuyết minh thêm 

thì ta có thể “lồng tiếng” cho phim. Lưu ý: kiểm tra xem microphone đã 

sẵn sàng cho việc thu âm chưa. Các thao tác thu âm như sau: 

 Nhấp vào More, chọn Voice Narration, nhấp Start recording để 

bắt đầu ghi.  
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 Nhấp Stop recording để kết thúc. Khi đó sẽ hiện ra hộp thoại yêu 

cầu lưu đoạn âm thanh vừa thu. Khi đã lưu xong, đoạn âm thanh 

này sẽ xuất hiện ở khe Audio của khung Timeline. 

 Biên tập âm thanh:  Nhấp vào Audio ở thanh công cụ (hoặc đưa 

chuột vào đoạn âm thanh ở khe Audio,  nhấp chuột phải, chọn Edit 

audio). Ở đây, ta có thể điều chỉnh âm lượng (Enable volume 

leveling, hoặc Colume down, Volume up), chỉnh âm thanh tăng 

dần (Fade in), âm thanh nhỏ dần (Fade out), tắt âm thanh 

(Silence), thêm điểm mốc trên đường biên âm thanh để hiệu chỉnh 

âm thanh to nhỏ một cách chi tiết (Add audio point). 
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Cách khác để tăng giảm âm lượng: nhấp vào Audio ở thanh công cụ, khi đó sẽ 

xuất hiện một đường ngang ở giữa đoạn âm thanh, đưa chuột đến đường ngang 

sẽ thấy mũi tên trắng theo chiều dọc, kéo mũi tên theo chiều lên hoặc xuống để 

tăng hoặc giảm âm lượng. 
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7. Cận ảnh thông minh 

Nếu quay một đoạn phim hướng dẫn sử dụng phần mềm có một vài chi tiết 

quá nhỏ không được rõ lắm, ta có thể phóng to những chi tiết quan trọng 

đó trên màn hình. Cách thực hiện như sau: 

 Nhấp thẻ Zoom-n-Pan > Nhấp nút Open Zoom Option > Đánh dấu 

vào Apply Smart Focus To Clips Added > Ok. 
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 Tại khung bên trái, dùng chuột co dãn vùng chọn hình chữ nhật và 

kéo vào vị trí cần phóng to. Kết quả phóng to sẽ hiểnthị trên khung 

Preview. 

 Khi cần phóng to thu nhỏ một cảnh nào thì kéo nút trượt ở khung 

Timeline đến cảnh đó. 

 Các cảnh áp dụng tính năng cận ảnh thông minh (Smart Focus) sẽ 

được nhận biết bằng ký hiệu ở khe Zoom trong khung Timeline. 

8. Hiệu ứng con trỏ chuột 

Ta có thể thay đổi kích thước và hiệu ứng nhấp chuột để đoạn phim trực 

quan hơn:  

 Nhấp vào More > Cursor Effects > Mouse Cursor Visible để làm 

xuất hiện con trỏ trong đoạn phim. 

 

 Chỉnh độ lớn con trỏ tại Cursor Size. 
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 Mục Highlight Effect làm nổi bật những vùng có trỏ chuột đi đến 

như Spot Light, biến con trỏ thành đèn pin để chiếu sáng vùng 

chung quanh. 

 Mục Left Click Effect / Right Click Effect cung cấp các hiệu ứng 

động khi nhấp chuột trái/ phải. 

 Để chọn âm thanh cho mỗi lần nhấp chuột, ta nhấp Click Sound 

Effect và chọn âm thanh cho chuột trái, chuột phải. 

 Hiệu ứng con trỏ chuột sẽ xuất hiện trong cửa sổ Preview, và được 

thể hiện ở khe Cursor trong khung Timeline. 

9. Tạo câu hỏi/ điều tra 

 Nhâp vào More > Quizzing. Khi đó sẽ xuất hiện khe Quiz ở khung 

Timeline. 
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 Nhấp vào Add Question nếu muốn tạo câu hỏi. 

 

 Nhập nội dung câu hỏi vào khung Question. 

 Nhập đáp án vào khung Answers. Nhấp vào Add nếu muốn tạo 

thêm câu đáp án. 

 Nhấp vào ô vuông trước đáp án đúng. Khi đó sẽ hiện từ “Đúng” 

phía sau đáp án. 

 Di chuyển thứ tự của các đáp án bằng cách nhấp Move up hoặc 

Move down. 

 Nhấp vào Preview để xem thử. 

Khi xuất phim, phải chọn lưu Web, hoặc định dạng là SWF mới xem 

được phần câu hỏi/ điều tra. 

VIII. THƯ VIỆN LƯU TRỮ 
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Nhấp vào thẻ Library ở thanh công cụ, xuất hiện nhiều hiệu ứng khác nhau về 

âm thanh, hình ảnh, đoạn phim  mẫu. 

 

Ta có thể kéo và thả những hiệu ứng này vào đoạn phim/ âm thanh trong 

khung timeline. Riêng đối với âm thanh, chỉ  có thể cho sử dụng khe Audio hoặc 

Audio 3 

Tạo thư viện riêng: nhấp phải lên đoạn phim/nhạc trong khung Timeline 

chọn Add  asset to Library. Đoạn phim/nhạc vừa chọn sẽ xuất hiện trong thư viện . 

Lần sau ta có thể dung lại đoạn phim/nhạc này một cách dễ dàng. 
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IX. XUẤT PHIM/ NHẠC 

Khi đã hoàn tất quá trình thu bài giảng và biên tập phim/nhạc, ta có thể xuất ra 

đoạn phim/nhạc với các định dạng như: SWF, FLV, AVI, WMV, MOV, RM,  GIF 

động và EXE. Ngoài ra, ta cũng có thể xuất ra để ghi vào CD hay đưa lên Web. 

Thông thường, ta nên xuất phim lưu trong máy: 

Nhấp vào Produce and share ở thanh menu, xuất hiện hộp thoại production 

Wizard, chọn chế độ cần xuất, click Next. 
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- Xuất hiện hộp thoại: 

 

. 
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Thông thường đối với đoạn phim, nên chọn định dạng WMV vì dung lượng 

không quá lớn, cũng không quá nhỏ, dễ tích hợp với các chương trình khác, hoặc 

định dạng FLV có dung lượng rất nhỏ, đối với đoạn âm thanh, chỉ có một định dạng 

MP3. Sau đó cứ nhấp Next. 

Khi xuất hiện Output file thì điền tên đoạn phim/nhạc, chọn đường dẫn để 

lưu. Cuối cùng, nhấp Finish. 

Xuất âm thanh của đoạn phim:nếu chỉ cần phần âm thanh mà không cần phần 

hình của đoạn phim, vào Fileproduce specialExport audio aschọn đường 

dẫn để lưu và đặt tên tập tin âm thanh (chọn định dạng mp3 hoặc wav). 

 

 

Xuất ảnh của đoạn phim: nếu muốn lưu lại một cảnh nào đó của đoạn phim 

thành tập tin hình ảnh riêng, ta vào FileProduce specialExport frame 

asChọn đường dẫn để lưu và đặt tên tập tin hình ảnh (chọn định dạng jpeg hoặc 

png). 
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 Lưu ý: Nên lưu lại đoạn phim đang biên tập dang dở để khi khác tiếp tục 

chỉnh sửa bằng cách nhấn ctr+s hoặc vào FileSave project. Đoạn phim 

được lưu có định dạng Camrec. 
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